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Introduction
There are two main sources of documentation for UniSim® CFE that 
will be discussed in the following sections:

• Manuals
• Online Help

Manuals

This Getting Started Guide forms part of the documentation supplied 
with each UniSim® Heat Exchangers program:

• UniSim® Heat Exchangers User Guide
• UniSim® CFE Getting Started
• UniSim® CFE Reference Guide.

The UniSim® Heat Exchangers User Guide is supplied in pdf format 
with the installation media. The Documentation media contains the 
UniSim® Heat Exchangers User Guide and all the other documents. 
The UniSim® Heat Exchangers User Guide is generic to all UniSim® 
Heat Exchangers programs. The Getting Started and Reference Guide 
are specific to each UniSim® Heat Exchangers program.

The Getting Started Guide assumes you have access to an installed 
copy of the UniSim® Heat Exchangers program, and takes you through 
some example cases provided with the program, so you can get a feel 
for its capabilities. It also describes how you can run a set of QA sample 
cases, and compare the output files with sample results, to confirm that 
the operation of the program is as it should be.

More detailed examples, showing how you can use the program to 
solve typical problems, are provided in Appendices to the program 
Reference Guide.

Online Help

The Online Help is the most extensive documentation available for 
UniSim® CFE. It is available whenever you are running the program, or 
can be loaded separately. There are direct links to appropriate Help 
topics for every input item, and from many other places in the 
program.

The Help provides information on data input and defaults, navigating 
through the Interface, the Program Output, and on Errors and 
Warnings. There is also general information on crossflow heat 

To load the Help when you 
are not running UniSim 
CFE, navigate to Program 
Files, Honeywell, UniSim 
Heat Exchangers Rxxx, 
UniSim CFE, CFE.CHM.
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exchangers, and the reasons for choosing particular design features as 
shown below.

You will also find information on UniSim® CFE capabilities, new features 
in the latest version, and contact points for user support.

The technical methods used in UniSim® CFE are proprietary. These 
methods are described in Design Report DR61.

 Figure 1

DR61 is the Design Report 
detailing the technical 
methods used in UniSim 
CFE.  
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Technical Support
Technical support is available by phone (1-403-509-1379 or 1-866-
392-8748 toll free in North America), fax (1-403-216-2801).

E-mail support for customers with a current support contract for their 
product is available.

On-line support can be accessed via http://www.honeywell.com/ps.

When contacting us via email or phone, please include in your 
message:

Your full name, company, phone and fax numbers.

The software version you are using (shown in the Help menu, About 
UniSim…).

A detailed description of the problem (attach a simulation case if 
possible).

Honeywell Email Address

Global unisim.support@honeywell.com

North America unisim.support@honeywell.com

Latin America unisim.support.lar@honeywell.com

Europe, Middle East, Africa unisim.support,emea@honeywell.com

Asia Pacific unisim.support.ap@honeywell.com
v

http://www.honeywell.com/ps
mailto:unisim.support@honeywell.com
mailto:unisim.support@honeywell.com
mailto:unisim.support@honeywell.com
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1.1 Introduction
Included with your UniSim® Crossflow Exchanger Modeler 
(referred to as UniSim® CFE) software are a number of example input 
files that will familiarize you with the program. The cases are fully 
defined and ready to run. You can simply open the cases and run 
UniSim® CFE to see the type of output that can be calculated. This 
Getting Started Guide will step you through one of these example cases 
as a brief introduction to the UniSim® CFE architecture, input options, 
and available output information. 

A complete set of results for the sample input files is provided in a 
separate location for quality assurance purposes in Chapter 2 - 
Testing the Installation.

A set of tutorials showing you how to set up input files for specific 
problems is included in Chapter 7 - Examples, of the Reference 
Guide.

1.2 Calculation Modes
Before examining and running the example input files, it is important to 
define the main types of calculations that UniSim® CFE can perform. 
These allow you to calculate the performance of air cooled/crossflow 
heat exchangers. The examples in the Reference Guide will elaborate 
on this, but for now the calculations will be described in the following 
sections.

1.2.1 Design
The program offers a range of exchanger widths and tube lengths, 
which satisfy the required thermal duty for a given X-side pressure drop 
and tube and fin geometry. The designer can select a design subject to 
constraints of maximum tubeside pressure drop and maximum and 
minimum tubeside velocities.

1.2.2 Checking
UniSim® CFE now offers a checking option which calculates a heat 
transfer area ratio (actual/required) to indicate whether a given 
exchanger will meet a required duty, calculated from the tubeside 
flowrate and inlet and outlet conditions. An area ratio equal to or 
greater than unity indicates that the exchanger will meet the required 
1-3



1-4 Calculation Modes
duty.

1.2.3 Simulation
UniSim® CFE offers nine simulation options:

• Standard simulation. Calculates the tubeside outlet 
temperature from the tubeside inlet temperature and flowrate, 
and the X-side inlet temperature and flowrate. Similar to the 
tubeside outlet temperature option described below, but uses a 
combined forward and backward iteration technique.

• Tubeside outlet temperature. Calculated from the tubeside 
inlet temperature and flowrate, and the X-side inlet temperature 
and flowrate. Similar to the Standard Simulation described 
above, but uses a purely forward iteration technique.

• Tubeside inlet temperature. Calculated from the tubeside 
outlet temperature and flowrate, and the X-side inlet 
temperature and flowrate.

• Natural convection. Calculates the X-side flowrate during 
natural convection. Can be used when all fans in an air-cooled 
heat exchanger are switched off.

• Tubeside flowrate. Calculated from the tubeside stream inlet 
and outlet temperatures and the X-side inlet temperature and 
flowrate.

• X-side flowrate. Calculated from the specified tubeside 
conditions and the X-side inlet temperature.

• Tubeside fouling resistance. Calculates a hypothetical 
tubeside fouling resistance to give a process duty that matches 
the duty calculated from the input tubeside conditions. This 
gives an indication of the surplus heat transfer surface area 
available.

• X-side face velocity. Calculates the X-side mass flowrate from 
a given X-side face velocity (at actual conditions) and the bundle 
geometry and then carries out a Standard Simulation (see 
above).

• Bundle pressure drop. Calculates the X-side mass flowrate 
from a given bundle pressure drop (at actual conditions), inlet X-
side stream density and the bundle geometry.
1-4
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1.3 Example 1
In this first example we will take a brief look at how an existing dataset 
can be reviewed, run and the outputs accessed.

1. Start UniSim® CFE. This can be done several ways and will depend 
on how you set up your desktop. However, the two main ways are:
• Click the Start menu, then Programs, Honeywell, UniSim 

Heat Exchangers Rxxx and UniSim CFE menu as shown 
below. 

• Use Windows Explorer and navigate to the CFE executable file.

After UniSim® CFE loads, you will see the main UniSim® CFE window 
and over this is the Welcome view. From this view you can either 
create a New file or open an Existing file. (If you have used UniSim® 
CFE previously, the project file you have worked with will appear in the 
Recently Used Project File list, making it easy to get back to files 
you were recently working on.)

2. Click the Existing button, to select an Existing file as shown below.

 Figure 1.1

 Figure 1.2
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1-6 Example 1
3. The Open Case view appears as shown.

4. Navigate to the following directory:

C:\Program Files\Honeywell\UniSim Heat Exchangers Rxxx\UniSim 
CFE\Samples. 

(This is the default directory, the exact location may be different if you 
changed the UniSim® CFE destination directory during installation.) 

5. Select the file QCFE01.CFEI. When the file has loaded, the Process 
Diagram view appears within the UniSim® CFE window as shown 
below.     

To open other files, select Open from the File menu.

 Figure 1.3

 Figure 1.4

If you cannot remember where a file is located, there is a 
Find File utility to help you. Select Find File from the File 
Menu or use the keyboard shortcut by pressing CTRL F.
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Getting Started 1-7
To use the Welcome view again, select Start Project from the View 
menu. (Note however, that you can only have one project active at a 
time.)      

1. Click on Input in the menu bar.

The Input menu gives access to all of the input data. The menu itself is 
divided into the different types of data you need to describe the heat 
exchanger and the operating conditions. These include different aspects 
of geometry, process conditions and physical properties. 

2.  Select Bundle Geometry from the Input menu. The Bundle 
Geometry view appears as shown below.

You should see values which give the basic bundle details such as 
nozzle and header data. This view is typical in that the data is entered 
in either a text box or via a drop-down list. The drop-down list shows 

 Figure 1.5

 Figure 1.6

Open icon

For most common 
activities there are 
shortcuts. To open a file, 
you can either click on the 
Open icon, or use the 
keyboard shortcut by 
pressing CTRL O.

Bundle Geometry icon
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1-8 Example 1
the list of possible values that you can enter. 

3. Look at the process data by selecting Process Data from the Input 
menu, by clicking on the Process Data button or by clicking on the 
navigation tree. The Process Data view appears as shown in the 
following figure.

4. This shows another view where the input items are arranged in the 
form of a spreadsheet. If the data do not fit on the view, a scroll bar 
allows you to access the other input items. The spreadsheet view is 
used when data are required several times (in this case, for the two 
streams in the exchanger).   

5. Finally, look briefly at the physical properties input by selecting 
Physical Properties.

The top level information about each stream is shown in the following 

If at any point you are not sure what input you want or 
something is not clear, you can press F1 and get context 
sensitive help. (i.e., if you select the Type of Header and 
press F1, you can see a list of the Header Types.)

 Figure 1.7

The left column is for the Tubeside Stream, and the right 
column is for the X-side Stream.

Process Data icon
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Getting Started 1-9
figure.

Depending on the type of physical property data you are working with, 
you can either enter the property data for the stream directly or enter 
data for components and allow UniSim® CFE to perform vapour liquid 
equilibrium and mixture calculations. All of the physical property data 
are managed through these views.

Since this is an existing case, all the necessary data has already been 
entered. 

6. Run UniSim® CFE by doing one of the following:

• Click on the Run icon in the tool bar; 
• Open the Run menu and select Calculate All;
• Press F4. 

UniSim® CFE now displays a status window that reports the progress 
of the run.

When the run is complete, there are three possible outcomes and 
corresponding outputs appear.

• Successful run with no fatal errors and no warnings. A view 
showing the Results Summary appears.

• Successful run with no fatal errors but with one or more 
warnings. The Results Summary appears with the Error/
Message Log which contains a description of the warnings that 
occurred.

• Failed run due to fatal errors. The Error/Message Log is shown 
with a description of the errors that occurred.

 Figure 1.8

Run icon
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1-10 Example 1
For this case, you will see the Results Summary which shows important 
results as shown below.   

There are many different outputs that can be viewed from the Output 
menu as shown below.  

Now you will look at the different types of output available.

 Figure 1.9

 Figure 1.10
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The first group of outputs are all special “Windows” outputs (views of 
the data that are in the form of graphs or tables):

1. Open the Output menu.
2. Select Graphical Results.

3. Select either Pressure Drops or Detailed Results views of the 
exchanger components.

4. Select Tubeside Pressure Drop.

5. Select Chart.

This produces a graph of pressure drop through the tubeside 
components as shown below. This will alert you to any unusual 
behaviour such as a high nozzle pressure drop.

Next there are outputs in the form of an API Specification Sheet. The 
first of these requires that you have Word for Windows available (this 
must be setup via Preferences from the File menu). The second is a 
view of the built in API sheet. (You will look at this further in the second 
example.)

If you want to know how your exchanger may appear, the Setting Plan 

 Figure 1.11
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1-12 Example 2
can give you various views such as that shown below.   

You can also get a budget estimate of a capital cost of a complete air-
cooled heat exchanger unit by selecting Budget Cost from the output 
menu.

The next group of outputs offers the facility to view the physical 
properties of each stream in tabulated format and perform various 
plots. It also offers tabulated information on temperature-enthalpy-
quality (THX) data and stream composition.

The final group of files are outputs generated directly by the calculation 
engine. They are all text files and contain different aspects of results 
generated. Of these, the one that you are most likely to use is the 
Lineprinter Output which contains all of the important information for 
your run.

1.4 Example 2
In the first example, you saw that there is a lot of data that can be 
entered for UniSim® CFE which demonstrates its full power. It is 
possible to reduce the amount of input you must consider in two ways:

• Basic mode
• Interactive API Input Sheet

To demonstrate data input through Basic Mode:

1. Open the Window menu and select Close All to close all the open 

 Figure 1.12
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views.
2. Open the File menu and select New. The Start up view appears as 

shown below.    

The Start up view (shown in Figure 1.13), also appears when you 
create a new file. It is here that you must make a decision about what 
type of calculation will be performed. You will see that Calculation Mode 
is currently set to Simulation; the Simulation Option is set to Standard 
Simulation, and the X-side Option is set to Dry Air.

3. Check the Basic Mode checkbox and click OK. 

In this input mode you will see the information needed to model the 
heat exchanger, but many of the special features, options and 
capabilities are hidden. To demonstrate this, click on the Input menu 
(as shown below) and you will see some of the input items are now 

 Figure 1.13

All the main input views have keyboard shortcuts; for 
instance, the Start up view is SHIFT F1; and Physical 
Properties Data is SHIFT F12.
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1-14 Example 2
hidden in comparison with Figure 1.5.

4. Now select API Input from the Input menu. The API Input view 
appears as shown below.        

 Figure 1.14

 Figure 1.15
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Getting Started 1-15
Many of the fields are blue. These are input fields and are directly 
connected to the main input forms. You can make changes here and 
they will be reflected in the main inputs. If you are creating a new case 
and you have data available in the form of an API Sheet, this method 
may speed up your data input.

Additional fields in grey allow the addition of comments or items that 
are not actually required for UniSim® CFE to run but may be useful in 
completing an API Sheet that can be printed.

1.5 Example 3
The main objective of this example is to demonstrate the UniSim® CFE 
Design Option capability.

1. Use Close All from the Window menu to close all the current 
views.

2. Select Open from the File menu to open the design example file 
QCFE07.CFEI from the default directory \Program 
Files\Honeywell\UniSim Heat Exchangers Rxxx\UniSim 
CFE\Samples. The Process Diagram view appears as shown below.   

By choosing the design option, the number of input items required for 
your exchanger are reduced (i.e., the input for Bundle Geometry). For 
example, in this case the Nozzles and Header details will disappear 
and other items will need less input data.

The most important input data required for the Design Option are 
Design Parameters for ACHE Geometry and Process Data where 
minimum and maximum values for these Design Parameters are 
defined to produce a range of exchanger designs.

 Figure 1.16

Design Mode is indicated 
on the Process Diagram.
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1-16 Example 3
3. Open the Run menu. Select Calculate All.

4. Click on the Run button, or press F4 to run the design. The 
UniSim® CFE Design Envelope appears as shown in the following 
figure. 

The Design Envelope consists of four lines:

• Thermal duty line which shows all of the heat exchanger sizes 
(overall exchanger width and tube length) that will satisfy the 
thermal duty;

• Maximum tubeside pressure drop line which shows the locus 
of all points where the tubeside pressure drop is equal to the 
maximum specified;

• Maximum & minimum tubeside velocity lines which show 
the relationship between the overall exchanger width and the 
tube length for given maximum and minimum tubeside 
velocities.

 Figure 1.17

Run icon

When the mouse cursor 
is within the design 
envelope, the overall 
exchanger width and 
tube length are shown 
for the current location 
at the bottom left of the 
screen.

Select a design by clicking in the Feasible Design Area. When the 
cursor is within this area, the text “Feasible Design Area” appears in 
the status bar at the bottom of the graph, and the cursor shape 
changes to a cross-hair.

The details of the design are shown under the 
Selected Design tab and are calculated from the 
information given under the Design Data tab. 
When a design has been selected, it can be 
refined by running a simulation.

The Possible Designs tab will show you 
other designs for the total exchanger width 
and tube length selected. The selected 
design has the lowest total number of fans 
and bundles.
1-16



Testing the Installation 2-1
2  Testing the Installation
2-1

2.1  Introduction .................................................................................. 3

2.2  Creating Output ............................................................................. 3

2.3  Comparing Outputs........................................................................ 4



2-2 Testing the Installation 

2-2



Testing the Installation 2-3
2.1 Introduction
A set of twelve sample UniSim® CFE cases, including both input and 
output files are provided with UniSim® CFE for Quality Assurance (QA) 
purposes. As a check that you have installed UniSim® CFE correctly, 
you should run the input files and compare your results files with those 
provided.

UniSim® CFE files have a file extension .CFEx (where x is an indicator 
of the type of file (input or one of the various outputs). A full listing is 
given in the Online Help. 

When you installed the software, the QA files are stored in a 
subdirectory (QADATA) of the directory containing the main UniSim® 
CFE folder. The twelve sample cases have file names QCFE01 to 
QCFE12, and file extensions are .QAx instead of .CFEx. The different 
extensions are used to ensure that you do not accidentally overwrite 
the QA files when running UniSim® CFE.

Copies of the twelve QA input files, with the standard input file 
extension .CFEI are installed in the ....\UniSim Heat Exchangers 
Rxxx\UniSim CFE\Samples directory by the installation procedure.

2.2 Creating Output
The first test on the installation is with QCFE1:

1. Copy the QCFE01.QAI file from the ....\UniSim Heat 
Exchangers Rxxx\UniSim CFE\QADATA directory to another 
directory (e.g., ....\My Documents\My UniSim Heat Exchanger 
Cases).

2. Rename the file, and give it the extension .CFEI (for example 
MYTEST1.CFEI.

3. Start UniSim® CFE. On the view that appears, click on Existing. 
Navigate to 

My Documents\My UniSim Heat Exchanger Cases\MYTEST1.CFEI. 

4. UniSim® CFE loads the case.    

5. Run UniSim® CFE with this case.

6. Compare the results files from your run with the results files 
supplied with UniSim® CFE.

7. Checks may be repeated with the other QA files supplied.

UniSim Heat Exchanger 
programs are now installed 
to \Program 
Files\Honeywell\UniSim  
Heat Exchangers Rxxx.
2-3



2-4 Comparing Outputs
2.3 Comparing Outputs
Your calculated results are files named MYTEST1.CFEx, in directory 
\My Documents\My UniSim Heat Exchanger Cases and these 
need to be compared with the supplied results files QCFE01.CFEx in 
directory ....\UniSim Heat Exchangers Rxxx\UniSim 
CFE\QADATA.

The most important comparisons are the .CFEV and .CFEL files but 
other files can be compared as well. The .CFEV file is the Results 
Summary and is a relatively short file. You can do the comparison 
using a file difference utility, or by printing off the two files and looking 
for differences.

If the files are identical, (except for the run time and input file name 
recorded in the output), the QA check is successful. If the files differ 
slightly, but only in the fourth or fifth significant figure of one or two 
variables, the QA check on this example is also successful. If there are 
more significant differences, consult Honeywell.

Remember, the QADATA 
files supplied with 
UniSim® CFE have the 
extension .QAx.
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